
The Ultimate Guide to Changing the Associated
Level of a Floor Plan in Revit

Description

How to Change the Associated Level of a Floor Plan in Revit

The process of changing the associated level of a floor plan in Revit can be an essential skill for
architects, engineers, and designers working with complex projects. In this guide, we will walk you
through the steps required to change the associated level of a floor plan in Revit, including:

1. Identifying the current associated level
2. Creating a new level or selecting an existing one
3. Changing the associated level
4. Verifying the change

Takeaways

Before diving into the details of this article, here’s a quick summary of the key points you’ll learn about
changing the associated level of a floor plan in Revit:

1. You can change the associated level of a floor plan or other elements by adjusting the ‘Level’
property in the Properties palette.

2. Changing the level of an element may affect its geometry, constraints, or relationships with other
elements, so verify your changes and make any necessary adjustments.

3. Levels in Revit are essential for defining the heights of building elements and organizing your
project.

4. Use descriptive level names to help you and your team quickly identify the correct level when
working with your project.

5. Adjust the ‘Underlay’ property of a view to control the visibility of elements from other levels.
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Identifying the Current Associated Level

Before making any changes to the associated level, you need to determine the current associated level
of your floor plan. To do this, follow these steps:

1. Open your project in Revit.
2. In the Project Browser, locate the floor plan you want to modify.
3. Click on the floor plan to open it in the drawing area.
4. In the Properties palette, look for the ‘Associated Level’ property. The value displayed is the

current associated level of your floor plan.

Creating a New Level or Selecting an Existing One

If you want to change the associated level to a new level or an existing level that is not yet listed, follow
these steps:

1. To create a new level, go to the ‘Architecture’ tab, click on the ‘Datum’ panel, and select ‘Level.’
2. Click on a point in the drawing area to place the start of the new level line, and then click on

another point to define the end of the level line.
3. In the Properties palette, set the ‘Name’ and ‘Elevation’ properties of the new level as desired.

OR

1. To select an existing level, go to the Project Browser, and expand the ‘Levels’ category.
2. Locate the level you want to associate with the floor plan, and make note of its name.

Changing the Associated Level

Once you have identified the new level you want to associate with your floor plan, follow these steps to
change the associated level:

1. In the drawing area, select the floor plan view you want to modify.
2. In the Properties palette, locate the ‘Associated Level’ property.
3. Click on the value of the ‘Associated Level’ property to reveal a drop-down list of available levels.
4. Select the desired level from the list.

Verifying the Change

After changing the associated level of your floor plan, it is important to verify that the change has been
successfully applied. To do this, follow these steps:

1. In the Project Browser, locate the floor plan you modified.
2. Click on the floor plan to open it in the drawing area.
3. In the Properties palette, verify that the ‘Associated Level’ property now displays the correct level.
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Best Practices for Changing the Associated Level of a Floor
Plan in Revit

While changing the associated level of a floor plan can be straightforward, there are some best
practices you should keep in mind to avoid potential issues:

Maintain consistency across views: Ensure that your changes to the associated level of a floor
plan are consistent across all views in your project. This will help prevent confusion and maintain
the accuracy of your project documentation.
Update dependent elements: Be aware that changing the associated level of a floor plan may
affect other elements in your project, such as grids, sections, and elevations. Be sure to update
these elements accordingly to maintain their correct relationships to the new associated level.
Document changes: Keep a record of any changes you make to the associated level of a floor
plan, including the reason for the change and any associated impacts. This documentation can
be valuable for future reference or for communicating changes to team members or project
stakeholders.

Use descriptive level names: When creating new levels, use descriptive names that accurately
represent their purpose within the project. This will help you and your team quickly identify the
correct level when making changes to the associated level of a floor plan.
Consider project phasing: If your project has multiple phases, ensure that the associated level
changes are appropriate for each phase. You may need to create additional floor plans or adjust
the level associations to accurately represent the building design in each phase.
Backup your project: Before making significant changes to the associated level of a floor plan,
consider creating a backup of your project. This will allow you to easily revert to a previous state
if something goes wrong or if the changes need to be reversed.

Troubleshooting Common Issues

Occasionally, you may encounter issues when attempting to change the associated level of a floor plan
in Revit. Here are some common problems and their solutions:
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The desired level is not available in the drop-down list: If the level you want to associate with
your floor plan is not available in the list, ensure that the level has been created in your project
and that its name is unique. If necessary, create a new level or rename an existing level to makeit
available for selection.
Elements on the floor plan disappear after changing the associated level: When changing
the associated level of a floor plan, some elements may become hidden or disappear due to their
association with the previous level. To resolve this, check the visibility settings for the view and
verify that the affected elements are associated with the correct level.
Floor plan view does not update after changing the associated level: If the floor plan view
does not update to reflect the new associated level, try closing and reopening the view or
refreshing the view by using the ‘Regenerate’ command. If the issue persists, check for errors or
warnings in the project that may be preventing the update.

FAQ: How to Change the Associated Level of a Floor Plan in
Revit

1. How do I change floor level in Revit?

To change the floor level in Revit, you first need to select the floor element in the drawing area. After
selecting the floor element, you will see its properties in the Properties palette. Locate the ‘Height
Offset From Level’ property and input the desired value for the new floor height relative to its
associated level. Alternatively, you can change the ‘Level’ property to associate the floor with a
different level in the project. Make sure to verify the changes by checking the floor’s elevation in the
drawing area or in a section/elevation view.

It’s important to note that changing the floor level will impact any elements hosted on that floor, such as
walls or columns. You may need to adjust these elements to align them with the new floor level or
update their constraints to maintain the desired relationships between elements.

2. How do you rename a level in Revit?

Renaming a level in Revit is a straightforward process. First, select the level you want to rename either
in the drawing area or in the Project Browser. With the level selected, go to the Properties palette and
locate the ‘Name’ property. Click on the value of the ‘Name’ property and enter the new name for the
level. Press Enter to confirm the change. The level’s name will be updated in the Project Browser and
in any view tags referencing that level.

Keep in mind that using descriptive level names can help you and your team quickly identify the correct
level when making changes or navigating your project. Also, be aware that renaming a level may affect
the visibility settings of certain elements or views, so it’s essential to verify that your project is
displaying correctly after renaming a level.

3. How do you change level in Revit without moving model?

Changing the associated level of a view or an element without moving the model can be done by
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adjusting the ‘Height Offset From Level’ property. For example, if you want to change the level of a
floor without moving the actual floor geometry, first select the floor element and go to the Properties
palette. Change the ‘Level’ property to the desired level and then adjust the ‘Height Offset From Level’
property to maintain the floor’s original elevation. This way, you change the level association without
affecting the geometry of the model.

Similarly, if you want to change the level of a view without moving the model, you can create a new
plan view with the desired level and adjust the ‘View Range’ settings accordingly. This will maintain the
original view’s position relative to the model while associating it with a different level.

4. How do you show floor level in Revit?

To show the floor level in Revit, you need to make sure that the Level Annotations are visible in your
view. If the Level Annotations are not visible, follow these steps:

1. Open the view in which you want to display the floor level (e.g., a section or elevation view).
2. In the Properties palette, locate the ‘Visibility/Graphics Overrides’ setting and click on the ‘Edit’

button next to it.
3. In the Visibility/Graphics Overrides dialog, scroll down to the ‘Annotation Categories’ section.
4. Find the ‘Levels’ category, and make sure the checkbox next to it is enabled.
5. Click ‘OK’ to close the dialog and apply the changes.

Your floor levels should now be visible in the view, along with the level lines and associated tags. If you
still can’t see the floor levels, double-check that the levels themselves are within the view’s extents and
that no filters or view templates are hiding them.

5. Can I change associated level Revit?

Yes, you can change the associated level of a floor plan or other elements in Revit.

1. In the Project Browser, locate the floor plan you want to modify.
2. Click on the floor plan to open it in the drawing area.
3. In the Properties palette, locate the ‘Associated Level’ property.
4. Click on the value of the ‘Associated Level’ property to reveal a drop-down list of available levels.
5. Select the desired level from the list.

Similarly, you can change the associated level of other elements such as floors, walls, or columns by
selecting the element and adjusting the ‘Level’ property in the Properties palette. Be aware that
changing the associated level of an element may affect its geometry, constraints, or relationships with
other elements in your project, so verify the changes and make any necessary adjustments.

6. How do I add levels in Revit 2020?

Adding levels in Revit 2020 is a simple process. Follow these steps to create a new level:

1. Go to the ‘Architecture’ tab.
2. Click on the ‘Datum’ panel and select ‘Level.’
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3. In the drawing area, click on a point to place the start of the new level line, and then click on
another point to define the end of the level line.

4. In the Properties palette, set the ‘Name’ and ‘Elevation’ properties of the new level as desired.

Make sure to create and name levels with clear descriptions to help you and your team quickly identify
the correct level when working with your project.

7. Where is Revit INI file located?

The Revit INI file is a configuration file that stores various settings and preferences for your Revit
installation. The location of the INI file depends on your operating system and Revit version:

For Revit 2021 and later versions: 
Windows 10/11: 
C:\Users\<username>\AppData\Roaming\Autodesk\Revit\Autodesk Revit 
<year>\Revit.ini

For Revit 2020 and earlier versions: 
Windows 10/11: 
C:\Users\<username>\AppData\Roaming\Autodesk\Revit\Autodesk Revit 
<year>\Revit.ini

In the file path, replace <username> with your Windows username, and <year> with the
corresponding year of your Revit version.

8. How do you create a level in Dynamo?

Creating a level in Dynamo can be done using the ‘Level.ByElevation’ node. Follow these steps:

1. Open Dynamo from the ‘Manage’ tab in Revit.
2. In the Dynamo workspace, search for the ‘Level.ByElevation’ node in the Library and drag it onto

the canvas.
3. Connect a ‘Number’ node or a ‘Number Slider’ node to the ‘elevation’ input of the

‘Level.ByElevation’ node to define the elevation of the new level.
4. To set a custom name for the new level, connect a ‘String’ node to the ‘name’ input of the

‘Level.ByElevation’ node and enter the desired level name.
5. Run the Dynamo script to create the new level in your Revit project.

Remember to save your Dynamo script if you want to reuse or modify it in the future.

9. How do I move a Revit model?

Moving a Revit model can be done using the ‘Move’ command. To move the entire model, follow these
steps:

1. Open a 3D view or plan view of your project in Revit.
2. Press Ctrl+A to select all elements in the view.
3. On the ‘Modify’ tab, click on the ‘Move’ command in the ‘Modify’ panel. 4. In the drawing area,

click on a base point to specify the start of the move vector, and then click on a second point to
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define the end of the move vector.

5. The entire model will move according to the specified vector.

Be cautious when moving an entire model, as this can lead to unintended consequences, such as
misaligned elements or incorrect annotation placements. It is essential to verify that all elements are
correctly positioned after moving the model.

10. How do I move multiple levels in Revit?

To move multiple levels in Revit simultaneously, follow these steps:

1. Open a section or elevation view that shows the levels you want to move.
2. Using the ‘Ctrl’ key, click on each level head to select the levels you want to move.
3. On the ‘Modify’ tab, click on the ‘Move’ command in the ‘Modify’ panel.
4. In the drawing area, click on a base point to specify the start of the move vector, and then click

on a second point to define the end of the move vector.
5. The selected levels will move according to the specified vector.

Make sure to verify that all elements associated with the moved levels are correctly positioned and
update any necessary constraints or relationships.

11. Why can I see the level below in Revit?

Seeing the level below in a Revit floor plan is often due to the ‘Underlay’ property of the view. The
‘Underlay’ property allows you to display elements from another level in a semi-transparent, non-
selectable state for reference purposes. To change or disable the underlay, follow these steps:

1. Open the floor plan view where you see the level below.
2. In the Properties palette, locate the ‘Underlay’ property.
3. Click on the value of the ‘Underlay’ property to reveal a drop-down list of available levels.
4. To disable the underlay, select ‘None.’ To change the underlay to another level, select the

desired level from the list.

12. How do you find missing levels in Revit?

To find missing levels in Revit, you can use the Project Browser to search for and locate levels within
your project:

1. Open the Project Browser by going to the ‘View’ tab and clicking on ‘User Interface’ > ‘Project
Browser.’

2. In the Project Browser, expand the ‘Levels’ category.
3. Scroll through the list of levels to locate any missing or hidden levels.

If a level is not visible in the drawing area or specific views, check the visibility settings for the view,
any applied filters, or view templates to ensure that the level is enabled and within the view’s extents.
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13. Why can’t I see my levels in Revit?

If you can’t see your levels in Revit, there may be several reasons:

1. The levels are not within the view’s extents. Adjust the view’s crop region or view range to include
the levels.

2. The ‘Levels’ category is hidden in the view. Check the Visibility/Graphics Overrides settings and
enable the ‘Levels’ category.

3. A filter or view template is hiding the levels. Verify the applied filters and view templates to ensure
they are not hiding the levels.

14. What is the purpose of story levels in a Revit project?

Story levels in a Revit project serve as reference planes that represent the elevation of different floors
or building levels. They are essential for defining the heights of various building elements, such as
walls, floors, and columns, as well as for creating views like floor plans, sections, and elevations.
Levels also help organize and manage the project by allowing you to associate elements and views
with specific levels, making it easier to navigate and understand the project’s structure. Additionally, 
levels can be used to control the visibility of elements in different views, enabling you to create more 
accurate and informative documentation.

15. How do I create a new level in Revit?

To create a new level in Revit, follow these steps:

1. Open a section or elevation view where you want to create the new level.
2. Go to the ‘Architecture’ tab.
3. Click on the ‘Datum’ panel and select ‘Level.’
4. In the drawing area, click on a point to place the start of the new level line, and then click on

another point to define the end of the level line.
5. In the Properties palette, set the ‘Name’ and ‘Elevation’ properties of the new level as desired.

Make sure to create and name levels with clear descriptions to help you and your team quickly identify
the correct level when working with your project.

Conclusion

Understanding how to change the associated level of a floor plan in Revit is essential for managing and
organizing your project effectively. By following the steps outlined in this article, you can easily modify
the associated level of a floor plan or other elements to suit your project’s needs. Remember to always
verify your changes and make any necessary adjustments to maintain the desired relationships
between elements and ensure the accuracy of your project documentation.

Revit’s level management system is a powerful tool for organizing and controlling the visibility of
various building elements in your project. By using descriptive level names and adjusting view
properties such as ‘Underlay’ and visibility settings, you can create clear and informative
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documentation for your project. With practice and attention to detail, you’ll soon become proficient at
managing levels in Revit and creating high-quality, well-organized building designs.
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